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Warranty Disclaimer 

The TympView software is provided by Welch Allyn for use in conjunction with the MicroTymp® 

4 tympanometer.  Welch Allyn provides no warranty (implied or otherwise) regarding this 

software and will not be liable for any aspect or consequences of its copying or use on a 3rd-

party computer.  By downloading and/or running the application, the user accepts these 

conditions. 

 

Notices: 

Information within this manual is subject to change without notice.  

Windows are registered trademarks of Microsoft Corporation. 
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PREFACE 

This user manual provides information about the TympView software program.  This manual is 

intended for technically qualified personnel.   

Please note: This User Manual is not intended as a training manual.  The reader should consult 

standard audiology texts for the theory and application of the tests stored by this program. 

 

INTRODUCTION 

Thank you for purchasing the Welch Allyn MicroTymp® 4 system.  The TympView software is 

provided by Welch Allyn to allow the data stored on the MicroTymp 4 system to be transferred 

to a PC.  If multiple tests have been stored in the MicroTymp 4 they can all be downloaded to a 

PC in a single operation.   

Tympanometric and acoustic reflex tests saved in the memory of the MicroTymp 4 

tympanometer may be transferred to a PC via a USB connection from the MicroTymp 4 cradle to 

a PC running the TympView software.  In the TympView software, tympanograms and reflex 

traces may be displayed in greater detail than on the screen of the device.  All the data and 

traces from both ears are presented on a single screen, allowing easy comparison.  If required, a 

tympanogram classification result according to the Jerger scheme may be added.  

Tympanogram reports may be printed or saved in pdf format for importing into other programs.   

 

SOFTWARE INSTALLATION 

Before installing the software confirm that the computer meets the minimum requirements. 

MINIMUM PC REQUIREMENTS  

• CPU: 2.0 GHz, Intel dual or quad core processor or better  

• RAM: 4 GB (or minimum required by OS) 

• Storage: 64 GB or larger 

• USB Ports: 1 minimum 

• Display: 10” or larger 

• Resolution: 1366 x 768 minimum 

• Touch screen or mouse/trackball 

SUPPORTED OPERATING SYSTEMS  

• Microsoft Windows® 10 Pro 

• Microsoft Windows® 7 Professional 
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SOFTWARE REQUIREMENTS  

The following should be installed if they are not already present on the PC. 

• Microsoft .NET Framework version 4.6 

INSTALLATION  

To install this application, the user must either be an Administrator or know the Administrator 

password. 

1. Insert the MicroTymp 4 USB into an available USB port. If auto-run is disabled, browse 

the USB drive and double click on the TympViewSetup.bat file. 

2. The Setup Dialog will be displayed. 

3. Select the “Start” button to install the software. 

4. Follow any on-screen instructions to complete the installation. 
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RECOMMENDATIONS 

The following recommendations will aid in the secure collection and storage of patient data.  

Please contact a local administrator for help and guidance.  

• Disable the “suspend USB” power option to ensure proper communication between 

instrument and PC. 

• Create backup of patients’ data regularly  

• Store backup of data in a safe manner. 

• To avoid data from being misused, if stolen, the data must be encrypted.  

• Ensure that an appropriate virus & spyware software is installed, updated, and 

effective.  

• All users should have a unique login to the PC.  

 

UNINSTALLING THE SOFTWARE 

1. Open the Windows Settings (Control) Panel. 

2. Select Apps (Programs) and Features. 

3. Select TympView. 

4. Select Uninstall. 

5. Follow the onscreen instructions. 
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CONNECTING THE MICROTYMP 4 INSTRUMENT 

The MicroTymp 4 is connected to the PC via a USB cable from the cradle.   

 

The MicroTymp 4 unit must be placed in the cradle for data to be transferred.  The cradle must 

be plugged into power and the device should be turned on.  The transfer of data is initiated 

from the TympView program running on the PC. 

 

OPERATING TYMPVIEW 

The TympView program may be launched from the Start->All Programs->TympView folder.  The 

TympView Main screen is presented with a title bar and menu at the top of the screen. 
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TITLE BAR 

The title bar contains the standard Windows control icons that allows the window to be 

minimized (-) and the program to be exited (X).  The program displays the main screen window 

maximized. 

MAIN MENU 

The Main Menu contains three options; File, Windows and Help.   

 

The File option is where you download the test results from the device, review and print the 

results.  The Windows option provides a means to select or close the results windows.  The Help 

option displays the about dialog which indicates the software version. 

File 

When the File menu option is selected, a dropdown sub menu is presented.   

 

Download from Tympanometer 

To view data in the TympView program the MicroTymp 4 test results must be downloaded from 

the device and then opened in the program.  The Download from Tympanometer transfers all 

the data from the device to the PC.  As the files are being transferred, a progress dialog is 

displayed indicating the record being transferred.  Each patient test is stored as a separate file 
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on the PC and automatically placed in a directory as specified in the Options menu item.  Files 

follow a specific naming convention: nnn_YYYYMMDD_HHMM.APX where nnn is either the 

initials entered when the test was saved in the device database, or ‘xxx’ (lower case) if none have 

been entered.  YYYYMMDD is the date of the test (in the format year, month, date); HHMM is 

the time of the test.  This naming convention ensures no two files are likely to have the same 

name.  Once transferred, the Open menu item is used to load and view the files in TympView.   

Download un-sent records from Tympanometer 

The Download un-sent from Tympanometer transfers only the data from the device that has not 

already been transferred to the PC.  The process is the same as the Download from 

Tympanometer. 

Open 

When the Open option is selected, the File Open dialog is presented where you can browse and 

select data that has been transferred from the device.   

Edit Record Details… 

Opens a new dialog that provides entries for the patient name, date of birth, ID/reference 

number and tester.  This information is not stored but appears on the printout of the test results. 

 

Options… 

Opens a new dialog that provides the specification for the location of the transferred data files.  

The files may be transferred to the user profile on the PC or the user may specify the specific 

location on the PC where the data will be transferred. 
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The specific location may be typed directly into the text box or the button at the end of the text 

box may be selected to browse the PC to select the directory.  

Print 

Opens the print dialog where you can select the printer and print the results. 

Print Preview 

Opens a new dialog that provides a preview of the record prior to printing.  From the Print 

Preview dialog, you can view the page layout and print or close the dialog.   

Print to PDF 

Opens a new dialog that prompts you for the PDF filename and location and then outputs the 

PDF file.   

Delete Viewed Files on Exit 

When checked, all files viewed in TympView will be deleted on exit. When un-checked, viewed 

files will be retained on exit. 

Exit 

Closes the TympView program. 
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Windows 

When the Windows menu option is selected, a dropdown sub menu is presented.   

 

The Windows sub menu allows you to select or close the results from any opened file. 

Close Current 

Close Current will close the displayed results windows.  The current window is indicated by a 

check mark in front of the file name in the file listing of the menu. 

Close All 

Close All will close all the listed results windows. 

xxx_yyyymmdd_hhmm.apx 

Each file that has been opened is listed in the sub menu.  Selecting the file makes it the current 

window and displays the results.  The currently selected results file is indicated by the check 

mark. 

 

Help 

The Help menu has a single item in the sub menu, About, which displays the TympView program 

version. 
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RESULTS WINDOW 

When the transferred file is Opened, the results are displayed.  Multiple files may be opened, 

and each file displayed in a separate window.  The results window displays the data for the right 

ear (red) on the left side of the screen and the left ear data (blue) on the right side.  The 

tympanogram and the measurements are displayed above the reflex data. 
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Tympanogram Results 

 

The tympanogram is plotted with the normative data box and the peak indicated by the X 

placed on the curve.  Any adjustment of the peak is performed on the instrument and cannot be 

changed in TympView program.   
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Tympanogram Measures 

 

The tympanogram peak measures are automatically calculated.  The Gradient measure is the 

tympanometric width.  The Result field has a dropdown menu where the Jerger tympanogram 

classification may be selected.  This classification will be printed but not saved with the data.  

The summary table for the reflex results by frequency and intensity are presented below the 

measurements.  Horizontal and vertical scrolls bars are used to display the data that is beyond 

the frame.  
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Reflex Results 

 

The reflex results display the reflex waveform with the level and frequency above the graph.  The 

summary table below the graph indicates the maximum compliance at the different stimulus 

levels.  The reflex results tables use the following to icons to indicate the result. 

 A reflex was detected, but this was not regarded as a valid reflex response by the device.  It 

is possible for the operator to modify the result to show a valid reflex (green check) after review 

of the reflex trace.  Click on the red X to make this change. 

 A reflex was detected, which was regarded as a valid reflex response by the instrument.  It is 

possible for the operator to modify the result to indicate that no valid reflex had occurred (red 

X) following review of the reflex trace.  Click on the green check to make this change. 

 No reflex test was performed at this level.  Depending on the settings of the device this 

could occur because a valid reflex response occurred at a lower level.   

 No reflex response occurred. 

 A further response occurred at a higher level of reflex stimulus.  If the Reflex Auto Stop 

option is set to “NO” in the instrument, reflex stimuli will be presented at all selected levels. 
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TROUBLESHOOTING 

ERROR MESSAGES 

Communication Errors 

 

 

This message is displayed when the download from the Tympanometer is selected and the 

device is not turned on.  Confirm that the device is turned on and the cradle is plugged into 

power. 

 

 

This message is displayed when the download from the Tympanometer is selected and the 

program cannot communicate with the device.  Confirm that the device is turned on, the cradle 

is plugged into power and that the connection to the computer with the USB cable is secure.  

The device should be powered on before starting the transfer.  Try closing the program, power 

cycle on the device and then restart the program.  You can continue without the connection, but 

the program will not be able transfer new data from the device.  However, you will be able to 

analyze data that has been previously transferred. 
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Device Driver Installation Error 

In most cases the installation of TympView and associated device drivers should be a 

straightforward process.  If after the software installation, your device is not recognized you may 

need to reinstall the device drivers.  The USB supplied with your device should contain a 

directory with the device drivers, open the folder ‘USB drivers’ and run the setup.exe program. 
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